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Overview 

You must have Windows and Internet 

Explorer to use Nightingale on Demand.  To 

set up your computer, you need to install a few 

components and adjust your Internet Explorer 

settings on each computer.  This guide will 

provide you with step by step instructions to do 

this.  

You must adjust these settings for each user 

(person) logging into the computer, since 

Internet Explorer settings that are set for one 

Windows User Profile will not carry over to 

another Windows User Profile.  

 

NOTE: We recommend you reset the Internet 

Explorer settings back to default before 

proceeding with this document to adjust 

your Internet Explorer settings 

 

Use the Recommended Version of Internet 

Explorer (IE) 

Windows XP will only operate with IE8.  

Windows 7 operates with IE8, IE9, IE10 and 

IE11. IE11 is recommended. 

Windows 8.1 and 10 operate with IE11. 

 

Beginning January 12, 2016 Microsoft officially 

retired Internet Explorer versions 8, 9, and 10 

for most Windows operating systems. Internet 

Explorer 11 is now the only officially supported 

version of the browser for Windows 7, 8, 8.1, 

and 10. Nightingale will also end its support for 

Windows XP, IE8, IE9 and IE10 on June 30, 

2016. 

 

Install the Java Runtime Environment (JRE 

or Java) 

When using Nightingale on Demand, you can 

perform several tasks such as signing 

documents electronically and drawing on 

growth charts and body images in patient 

encounters. In order to use these features, you 

will need to install a program on your computer 

called the Java Runtime Environment (JRE or 

Java). Install the JRE using the following steps: 

 

1. Log on to your computer using a Windows 

profile that has administrative rights, so 

that you can download and install the Java 

program. 

 

2. Recommended version of JRE  

a. For PCs running a 64-bit Windows 

operating system (OS): The bit-ness 

(i.e. 32 bits or 64 bits) of the JRE 

must match the bit-ness of Internet 

Explorer that you use. It is 

recommended that NOD users use 

the 32-bit version of Internet Explorer 

and the 32-bit version of the JRE. 

Both 32-bit and 64-bit versions of 

Internet Explorer are available on a 

PC with a 64-bit OS, but the default 

version is 32-bits. 

b. At the time of writing, the 

recommended version of JRE for 

Windows 7, 8, 8.1 and 10 is 8u74 

(also referred to as 8 update 74 and 

1.8.0_74).  

c. As of April 8, 2014 Microsoft stopped 

supporting Windows XP and 

therefore it is no longer an officially 

supported platform. Users may still 

continue to use Java 8 updates on 

Windows XP at their own risk, but 

Oracle can no longer provide 

complete guarantees for Java on 

Windows XP, since the OS is no 

longer being updated by Microsoft. 

 
3. Download and install the JRE from the 

following website: 

http://www.oracle.com/technetwork/java/javas

e/downloads/index.html.  

4. When you get to the website: 

a. In the section labelled “Java Platform, 

Standard Edition, click on the button 

labelled “JRE DOWNLOAD”.  

http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://www.oracle.com/technetwork/java/javase/downloads/index.html
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b. In the new page, click on “Accept 

License Agreement”.  

c. Select the “Windows x86 Offline link” 

– The larger file.  

d. A pop-up window will prompt you to 

start the java download.  

e. Click on Run. 

f.      Follow the instructions on the screen 

to install the program. 

 

Adjust Windows Settings to Print Reports 

Correctly  

You must adjust some settings on your 

computer so that your reports print with the 

proper margins.  Depending on the version of 

Windows you have, these steps may be slightly 

different.   

 

Note:  Also, while on your desktop, please do 

not create desktop shortcuts to the Nightingale 

On Demand training and production 

applications. 

 

Adjust Display Settings 

Steps for Windows XP 

1. Right click on your computer desktop and 
click Properties. 

2. Click the Settings tab.  Under Screen 
resolution, use the sliding bar to select 
an option that has a ratio of 4:3.  For 
example, you can select 1400 x 1050 - or 
- 1024 x 768 - or - 800 x 600). 

 

3. Click the Advanced button.  In the DPI 
setting: box, select Normal size (96 DPI). 

 

 

 

4. Click the OK button. 

5. A window will appear with the message - 
Your desktop has been reconfigured.  
Do you want to keep these settings?  
Click the Yes button. 

6. Click the OK button on the Display 
Properties window (which may still be 
open) to finish. 

7. Log off if prompted, and log on again. 

 

Adjust Display Settings 

Steps for Windows 7 

1. Right click any empty area on your 
desktop, choose Screen resolution. 

2. Beside Resolution, use the arrow and 
slider to select an option that has a ratio of 
4:3.  For example, you can select 1400 x 
1050 - or - 1024 x 768 - or - 800 x 600).   

 

3. Click outside the resolution drop down list 
box and click the OK button. 

4. A window will appear with the message- 
Do you want to keep these display 
settings? To accept the change, click the 
Keep changes button.  If you do not like 
the change, click the Revert button. 
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5. Right click on an empty area of your 
desktop and choose Personalize.  

6. Click on the Display link at the bottom left 
corner. 

7. Choose Smaller. (Smaller - 100% = 96 
DPI) 

 

8. Click on the Apply button. 

9. Log off if prompted, and log on again. 

 

 

Adjust Regional and Language Options 

Steps for Windows XP 

1. Click on the Start button, select Settings 
and select Control Panel. 

 

2. Click Date, Time, Language and 
Regional Options. 

 

3. Click Regional and Language Options. 

 

4. From the Select an item to match its 
preferences, or click Customize to 
choose your own formats: box, select 
English (United States) and click OK. 

 



Last Updated October 2016   

Nightingale – Getting Started Guide – Windows XP / 7      Page 6 of 12 

 

Adjust Regional and Language Options  

Steps for Windows 7 

1. Click on the Start button and select 
Control Panel. 

 

2. In the top right corner, use the small arrow 
to change the View to Large icons. 

 

3. Click Region and Language.   

 

4. On the Location tab, use the arrow 
beside the Current location: box, to 
select United States. Then click the OK 
button. 

 

5. Click the red x in the top corner of any 
remaining open windows to close them. 

 

 

 

 

 

Check Your Internet Explorer Version  

 

To find out what version of IE  

you are using, complete the following steps.  

 

1. Open Internet Explorer. 

2. Click on the Help menu and select About 
Internet Explorer. 

 
 

 

Depending on the version of IE you have you 

will see the appropriate screen (see below) 

 

 

    Internet Explorer 8         Internet Explorer 9 

 

Internet Explorer 11 

 

 

 

3. Click the OK button when you are 
finished. 

 

Adjust Internet Explorer Print Settings  

 

When you print pages using Internet Explorer, 

you have the option to prevent unwanted items 

from appearing at the top and bottom of each 

page (in the header and footer area).   

It is important to remove these items so that 

they will not appear when you use Nightingale 

On Demand to print reports. 

1. Open Internet Explorer. 

2. Click the File menu and click Page Setup. 
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3. Look in the Header box and the Footer 
box. Select – Empty. 

4. Change all margins to 0.25.  Do this by 
typing 0.25 in the Left:, Right:, Top:, and 
Bottom: boxes. 

 

Internet Explorer 8 Or Greater 

 

5. When complete click the OK button. 

  

Activate the Internet Explorer Menu Bar 

□ Open Internet Explorer. 

□ You should see the Menu Bar at the top of 
your screen.  (I.e. File, Edit, View, Favorites, 
Tools and Help). 

□ If you do not see it, right click on an empty 
space in the toolbar area and click on Menu 
Bar to select it, or press the ALT key on the 
keyboard. 

□ The Menu Bar should now be at the top of 
your screen. 

 
 

 

Allow Pop-ups by Turning off the Pop-Up 

Blocker  

□ You must ensure that Pop-ups are allowed 
to appear, before logging on to the 
Nightingale program. To do this, you must 
ensure that the Pop-up Blocker option is 
turned off. 

□ Click on the Tools menu and click Pop-up 
Blocker. 

□ If you see the option - Turn off Pop-up 
Blocker, click on it.  If you do not see the 
option, then this option is already turned off 
and you do not need to do anything else. 

 
Note: For helpful instructions on how to turn off 

the Pop-up Blocker feature in other programs 

you may have installed before, reference 

Nightingale’s Corporate Website 

 

You will find the following helpful instructions. 

□ How do I allow pop ups in McAfee 
Internet Security? 

□ How do I allow pop ups in Norton 
Internet Security? 

□ How do I allow pop ups in Spyware 
Doctor? 

□ How do I remove Yahoo? 

□ How do I remove Google? 

 

 

Adjust Your Internet Options 

1. Click on the Tools menu. 

 

2.  Click Internet Options. 

 

3. On the General tab, in the Browsing 
history section, check Delete browsing 
history on exit. 

4. Click the Settings button. 
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5. The Temporary Internet Files and 
History Settings window will appear.    

6.  Under Check for new versions of 
stored pages: select Automatically. 

7.  Beside Disk space to use, select or type 
50. (This number can vary depending on 
the size of your hard disk.  If you have 
your own technical support staff, you can 
check with them to see if you should be 
using another number.  Otherwise, just 
use 50). 

8.  In the Days to keep page in history box, 
select or type 2. (May be TAB on newer IE 
Versions) 

 

9. Click the OK button. 

10. On the General tab, in the Browsing 
history section, click the Delete button 

11. The Delete Browsing History window will 
appear.    

12.  Uncheck “Preserve Favorites website 
data” and “Passwords”. All other options 
should be checked 

13. Click the Delete button. 
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14. Click the Security tab. 

15. Click the Trusted Sites option. 

16. Click the Sites button.  

17. The Trusted Sites window will appear. 

18. Click the Default level button.   

 

 

19.  In the Add this website to the zone: 
box, add all of the Nightingale On Demand 
websites that you will be accessing. To find out 
which websites you will be accessing, look in 
the following table.  A row in the table will apply 
to you.   

 

Note: You must enter the websites one at a 

time and press the Add button after each one.   

 

In the picture below, the Ontario MD Server is 

used as an example. The first website has been 

added and the second website is about to be 

added. 
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The following table contains a list of Nightingale 

environments and the corresponding websites.   

 

Look at the table and determine which row 

applies to you. 

 

Nightingale 

Environment 

Websites to Add 

NOD – 

Ontario East 

https://rsa-on.mynightingale.net 

NOD – 

Ontario MD 

https://ont.nightingale.md 

NOD – AOHC https://aohc.nightingalemd.com 

NOD – 

Eastern 

(Outside of 

Ontario) 

https://nod.nightingalemd.com 

NOD - 

Western 

https://rsa-

west.mynightingale.net 

NOD – 

Western 2 

 

https://west2.nightingalemd.com 

Training 

Server 

https://training.mynightingale.net 

20. Once you have added all of the websites, 
click the Close button. 

21. On the Security tab with the Trusted Sites 
icon selected, click the Custom level 
button.  

22. The Security Settings - Trusted Sites 
zone window will appear.  You will need to 
change the values to match the pictures 
below.  The name of each section has 
been added to make it easier for you to 
find each option.   

 

Note:  Some options may not appear, 

depending on the version of Internet 

Explorer you are using. For example, in 

Internet Explorer 8, the Phishing Filter 

feature has been replaced by the Smart 

Screen Filter and In Private Browsing.  If 

they do not appear on your computer, just 

skip that step and move on. 

 

ActiveX controls and plug-ins 

 
 

Downloads  

 Miscellaneous 

 

 
 

23. Click OK. 

24. Click Yes when prompted Are you sure 
you want to change the settings for 
this zone?  

25. Click the Advanced tab. 

26. Under the Security heading, ensure that 

‘Enable native XMLHTTP support’ is 

checked. 
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27. Click OK to save changes and to close the 
Internet Options window. 

Adjusting Compatibility View Setting with 

Internet Explorer 9/10/11 

□ On any Internet Explorer page, click on 
Tools, then click on Compatibility View 
Settings.  The Compatibility View 
Settings window will appear on the 
screen.  Remove the check marks from 
the checkboxes for Use Microsoft 
compatibility lists and Display 
intranet sites in Compatibility View.  
Click Close to save your changes. 

 

 

 

 

 

Configuring Java Settings on Internet 

Explorer 11  

□ Click on Start, then double click on 
Control Panel 

□ Double click on Java (32-bit) 

□ Click on the Security  Tab  

□ Set the Security Settings to High 

□ Click OK. 

 

□ Click on the General Tab 

□ Click on Settings button under 
Temporary Internet Files 

 

□ Click Delete Files 
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□ Click Ok, then Ok again 

 

□ Click on the Java Tab 

□ Disable or delete any previous versions 

of Java that may be installed. Click Ok. 

 


